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Introduction
This is the administrator’s guide for Viz NLE version 1.8.
This section contains information on the following topics:
• About the Document
• Contact Vizrt
• Contact Vizrt

1.1

About the Document
This manual covers the information needed in order to install and configure Viz
NLE version 1.8.
The purpose of this document is to help new Viz NLE administrators become
familiar with the system; to illustrate the installation process, and show the
available configuration options.
This section contains information on the following topics:
• Document Structure
• Related Documents
• Conventions

1.1.1

Document Structure
Sections 1 and 2 introduce the Viz NLE plugin, giving an overview of the
supported operating systems, new features, limitations, and basic workflow.
Section 3 describes requirements and recommendations noteworthy before
installing the plugin.
Section 4 gives an easy-to-follow guide on how to setup the Viz Engine for
graphics rendering with the NLE plugin. It also gives a quick overview of the Viz
Connection Broker installation and use, and also a more in-depth step-by-step
description of how to setup the Viz NLE plugin for both Apple and Windowsbased systems. Last but not least, this section also provides a test for each
supported NLE system.
Section 5 explains the user interface; general and advanced configuration, and
performance testing. In most cases these settings are not needed by the average
user; however, specific situations may raise the need to tune the system. For more
information, please contact your local Vizrt representative.
Section 6 gives an in-depth explanation on how to tune the Viz NLE plugin.
Section 7 is a summary of frequently asked questions. This section also covers
information on logging and how to report issues back to Vizrt.
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1.1.2

Related Documents
For complementary information, see the following documents:
• Viz Artist User’s Guide: How to create scenes.
• Viz Content Pilot User’s Guide: How to install and use the Newsroom
Component.
• Viz Engine Administrator’s Guide: Contains list of supported graphics cards.
• Viz Template Wizard User’s Guide: How to create and organize templates to be
used by the Newsroom Component.
• Viz Trio User’s Guide: How to install and use the Viz Trio client.

1.1.3

Conventions
The following typographic conventions are used in this document:

• Italic is used for non-hyperlink external references, such as related
documents, books, or Internet pages. Italic is also used to emphasize words.

• The color blue is used for hyperlinked external references, and also internal
references to sections or document elements (such as tables or figures) in the
current document.
• Bold refers to GUI components.
1. Numbered paragraphs are used to indicate tasks that must be carried out.

1.2

Contact Vizrt
We encourage your suggestions and feedback regarding the products and this
documentation. In order to provide feedback, please identify your local Vizrt
customer support team at www.vizrt.com.

2

Chapter 1: Introduction

2

Viz NLE
Viz NLE is a plugin that integrates Vizrt’s graphics workflow into the non-linear
editing (NLE) workflow.
Using the Viz NLE plugin, NLE system users can access Vizrt’s control applications
and easily add real-time rendered Vizrt graphics while editing video clips.
Viz Trio, Viz Content Pilot’s Newsroom Component, and the Viz NLE Editor are all
graphical user interfaces that allow the user to interact with and edit graphics
elements. The Viz NLE plugin supports NLE systems on both Windows and Apple
platforms. Viz Trio and the Newsroom Component are both available to Windowsbased NLE systems, whereas the Viz NLE Editor is available to Mac-based NLE
systems.
The Viz NLE plugin integrates with various NLE systems, for details see Supported
NLE Systems. Though the versions are tailored to the specific platform, the overall
setup and user interface remains the same.
This section contains information on the following topics:
•
•
•
•

2.1

Solutions
New Features
Current Limitations
Workflow

Solutions
The Viz NLE plugin supports two operating systems; Microsoft Windows and Intelbased Apple Macintosh computers using OSX 10.4 or later. The basic setup is in
principle the same; however, there are some differences in how they are used, and
what software is used in addition to the plugin.
Both setups need a Viz Engine for graphics rendering, and a database that stores
the data for each graphics template or data element. The “database” can either be
a Media Sequencer or a Viz Content Pilot (VCP) database. The VCP database can
only be used by Windows-based Viz NLE plugins in conjunction with the
Newsroom Component.
The main components used with the Viz NLE plugin are:
• Viz Engine is a real-time graphics renderer, and at the core of the Vizrt
graphics workflow.
• Viz Multiplexer is a small proxy, handling Viz Engine scene states of different
effects, that allows a single Viz Engine to be used by several effects. The Viz
Multiplexer can also serve several users and workstations, allowing a single
Viz Engine to be used by several clients.
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IMPORTANT! Viz Multiplexer is only used with Viz Engine 2.x versions. Viz Engine
3.x has a built-in multiplexing functionality, similar to the standalone Viz
Multiplexer.

• Viz Connection Broker performs connection broking, providing all NLE system
users with a single connection point for graphics rendering.
• Media Sequencer is a framework for defining and executing media elements
on a Viz Engine. The media elements are defined in a tree-based schedule that
the Media Sequencer interprets, but for Viz NLE, it is simply used as a storage
solution for Viz Trio, which is used by Viz NLE Editor.
• Viz Content Pilot database is an Oracle 10g or 11g database that stores
template data and references to the template graphics. The VCP database is
mainly used in conjunction with the Newsroom Component.
This section contains information on the following topics:
• Windows-based Systems
• Mac-based Systems

2.1.1

Windows-based Systems
For Windows users there are two editors available for adding graphics to a video
clip; Viz Trio and VCP’s Newsroom Component. Viz Trio is bundled with the Viz
NLE plugin installer, whereas the Newsroom Component must be installed
separately, as it connects to the VCP database for the template data and graphics.
See Also
• Supported NLE Systems
• Windows-based Non-linear Editing Systems (details on installation and
configuration)

2.1.2

Mac-based Systems
For Mac users the Viz NLE plugin has its own built-in graphics editor; Viz NLE
Editor. The editor is capable of reading Viz Trio shows stored on the Media
Sequencer and remote previewing the Viz Engine graphics as well as editing the
text and image properties of graphic scenes.
The Mac-based Viz NLE plugins are unable to control or use Viz Trio and the
Newsroom Component remotely as a user interface, hence the Viz NLE Editor.
See Also
• Supported NLE Systems
• Mac-based Non-linear Editing Systems (for details on installation and
configuration)

2.2

New Features
The following new features have been added to the various Viz NLE plugins:

4
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•
•
•
•

2.2.1

Viz
Viz
Viz
Viz

NLE
NLE
NLE
NLE

for
for
for
for

Adobe
Avid
Final Cut
Quantel

Viz NLE for Adobe
Previous Viz NLE versions have not supported Adobe Creative Suite (CS). Version
1.8 of Viz NLE for Adobe is the first release of this plugin. Viz NLE for Adobe
version 1.8 works together with Adobe Premiere from version CS5 (including
versions CS5.5 and CS6).

2.2.2

Viz NLE for Avid
Viz NLE for Avid version 1.8 contains the following new features:
• The Viz NLE plugin can now do in-place blending. This means that it can
operate directly on the host program's image buffer if the host program
supports it. The Viz NLE plugin only blends the minimal rectangle that
includes all the graphics. This will give a small but measurable performance
increase, especially on small graphics.
• The Viz NLE plugin is now completely independent of the Viz Engine's frame
rate.
• Viz Engine 3.5 introduces support for image fetching in custom sizes. The
plugin has been changed to take advantage of this if the Viz Engine supports
it. This means that a Viz Engine can now be used in projects that have a
resolution less than or equal to the resolution of the Viz Engine.
• The plugin now supports anti-aliasing. A setting was introduced to control
this, by default this option is enabled. The plugin is then able to produce
smoother graphics, especially in mobile formats. The Viz Engine must use a
resolution of at least twice the size of the requested frame to provide this
feature. This happens on the Viz Engine’s GPU, so the overhead is very small.
• The plugin now supports the following Viz Engine video modes (added in Viz
Engine 3.5):
• 1080P 50 FPS
• 1080P 59.94 FPS
• 1080P 60 FPS

2.2.3

Viz NLE for Final Cut
Viz NLE for Final Cut version 1.8 contains the following new features:
• The Viz NLE Editor now supports using images stored in Viz Content Pilot's
image database; Viz Object Store. This requires version 5.6 of Viz Content
Pilot. A new setting called VOS Image Search has been introduced. Users can
enter a URI template here, and this will enable the new feature.
• The Viz NLE plugin is now completely independent of the Viz Engine's frame
rate.
• Viz Engine 3.5 introduces support for image fetching in custom sizes. The
plugin has been changed to take advantage of this if the Viz Engine supports
it. This means that a Viz Engine can now be used in projects that have a
resolution less than or equal to the resolution of the Viz Engine.
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• The plugin now supports anti-aliasing. A setting was introduced to control
this, by default this option is enabled. The plugin is then able to produce
smoother graphics, especially in mobile formats. The Viz Engine must use a
resolution of at least twice the size of the requested frame to provide this
feature. This happens on the Viz Engine’s GPU, so the overhead is very small.
• The plugin now supports the following Viz Engine video modes (added in Viz
Engine 3.5):
• 1080P 50 FPS
• 1080P 59.94 FPS
• 1080P 60 FPS

2.2.4

Viz NLE for Quantel
Previous Viz NLE versions have not supported Quantel QEffects. Viz NLE for
Quantel version 1.8 is compatible with Quantel QEffects 4.2 and higher.
Note: This plugin is a complete re-write of the older Viz NLE Plugin 1.3.4 for Quantel
QEffects, which supported QEffects versions 3.6 to 4.1.

2.3

Current Limitations
There are limitations to what a Viz NLE plugin solution can do compared to a full
SDI in and out Viz Engine renderer.
These are the general Viz NLE plugin limitations on both Mac and Windows:
•
•
•
•

Does not support transition logic scenes
Does not support stop point control in multiple reveal graphics
Embedded sound effects and video clips in graphics are not supported.
When the NLE is connected to Viz Engine 2.x, it will use no compression if the
RLE option has been selected.
• Media Sequencer 1.19 and older, as well as Viz Engine 3, do not announce
their presence on the computer network. Therefore, the Viz NLE Config tool
will not yet auto-discover these services. However, Viz Connection Broker and
Viz Multiplexer 1.4 (used with Viz Engine 2.8) will announce themselves.
These are the specific Viz NLE plugin limitations on Windows only:
• For Avid installations, not all Viz NLE versions, prior to 1.5, are automatically
removed when upgrading.
These are the specific Viz NLE plugin limitations on Mac only:
• Editor Input: In the current version, it is only possible to input text, change
numeric values, and select images/geometries/fonts/materials. There is no
support for input of boolean values. There is no support for editing
ControlList/Tables or Scrolls. However, the editor can pick up Viz Trio pages
created using a regular Viz Trio, and render them even though they may have
these field types.
• No import in editor: The Viz NLE Editor cannot create shows and import
scenes yet, so currently you need to use Viz Trio 2.6 or later to create shows
and import scenes for the Viz NLE Editor to use.
6
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2.4

Workflow
The following diagram illustrates the NLE workflow.
Figure 1: NLE workflow

The basic workflow from template design to rendering is:
• A graphics designer creates a graphic scene in Viz Artist.
• The scene is either added as a template to a Viz Trio show or created as a
template for use with VCP’s Newsroom Component in Viz Template Wizard.
• An editor or a journalist edits a video using an NLE system.
• Using the Viz NLE plugin, the user can access and add graphics to the video.
• Graphics properties can be edited using the graphics templates in either Viz
NLE Editor, Viz Trio, or the Newsroom Component.
• The video clip is rendered and saved to a shared file server or a Media Asset
Management (MAM) system, such as Viz One.
• Once the file is saved or posted to the MAM system, it can also be added to a
playlist for playout on Viz Engine.
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3

Requirements and Recommendations
This section covers hardware, software and network requirements and
recommendations, information about supported NLE systems, and necessary
references to other Vizrt system guides for complementary information.
This section contains information on the following topics:
• Software
• Hardware
• Network

3.1

Software
This section gives an overview of the supported Vizrt software and NLE systems
supported by the Viz NLE Plugin.
This section contains information on the following topics:
• Vizrt Systems
• Supported NLE Systems

3.1.1

Vizrt Systems
Vizrt recommends the following software versions when using NLE systems with
Vizrt’s content control applications:
• Viz Connection Broker 1.1
• Optional, it is still possible to specify a specific Viz Engine directly
• Requires Microsoft .NET 4.0
• It can be installed on the same server as a Media Sequencer or Viz Engine. If
installed on a Viz Engine that is part of the pool Viz Connection Broker
manages you should ideally place Viz Connection Broker on another
machine in case of machine failure.
• Viz Engine 2.8 patch level 5 and hotfix 3 and 19 recommendations:
• Viz Multiplexer version 1.4.1
• Extra Viz plugins 1.9.1 and later (older versions are supported, but latest
available version is recommended)
• Microsoft Windows XP (32-bit)
• Viz Engine 3.2.8 and later recommendations:
• Recommended Viz Engine versions are 3.2.8, 3.3.1, or 3.5.2 and later
• Viz Engine 3.3.0, and 3.2.7 or earlier, has some known issues that can
cause (rare) rendering artifacts when multiple NLE clients are using the
same engine.
• It is highly recommended to have a fast (Gigabit) network connection
between each NLE workstation and Viz Engine
• This version of Viz NLE only supports UTF-8 encoding for the Viz Engine

8
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• Microsoft Windows XP (32-bit)
Note: Viz Multiplexer should not be used with Viz Engine 3, since it has built-in
multiplexer support.

Note: Extra Viz Plugins must be installed on Viz Engine versions up to 3.2.x.

• Media Sequencer 1.20.1
• Required when using Viz Trio, not when using Viz Content Pilot
• Required when using Mac
• Requires Microsoft .NET 4.0
• It can be installed on each NLE workstation, or on a server
• Installing it on a server makes it easier to share graphics elements between
Viz Trio NLE clients
• Elements saved to a Media Sequencer from Viz Trio can be used from the
Viz NLE Editor for Mac OS X, and vice versa
• Installing it on a Viz Engine server is not recommended since high memory
usage can interfere with Viz Engine performance.
• Viz NLE Plugin for Mac supports:
• Media Sequencer data created by Viz Trio 2.6 or newer
• Apple OSX 10.4, 10.5 10.6, and 10.7 on Intel hardware
• All OSX versions are limited to the Intel-based Mac with latest software
updates.
Note: Viz NLE Editor for Mac only supports Media Sequencer versions 1.18 and later.

Note: Older versions of Viz Trio will work; however, it is important to check which
version of the Media Sequencer and Viz Engine it supports.

• Viz NLE Plugin for Windows supports:
• Viz Trio version 2.6 or later (version 2.10.2 is bundled)
• Viz Content Pilot Newsroom Component 5.0 or later
• Viz Engine 2.8 pl 5 hf3 or later with Viz Multiplexer version 1.4
• Viz Engine 3.2.8 or later
• Microsoft Windows XP (32 bit) and Windows 7 (32 and 64 bit)
• Requires Microsoft .NET Framework 3.5

3.1.2

Supported NLE Systems
The list below is the current list of supported NLE systems that is within the scope
of this guide. Other versions are not officially supported unless it is specifically
mentioned as part of this document.
The following systems are supported:
• Adobe Premiere
• Apple Final Cut Studio

Chapter 3: Requirements and Recommendations
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• Avid Media Composer and Avid NewsCutter
• Quantel QEffects
Adobe Premiere
The Viz NLE for Adobe plugin works together with Adobe Premiere from version
CS5 (including versions CS5.5 and CS6). This plugin works on both Windows- and
Mac-machines.
Note: Previous Viz NLE versions have not supported Adobe Creative Suite (CS). In
addition to Adobe Premiere, the Viz NLE for Adobe plugin support Adobe
AfterEffects from version CS5.

Apple Final Cut Studio
The Viz NLE for Final Cut plugin works together with Apple Final Cut Pro 6 and 7
(available in Final Cut Studio 2 and 3, respectively). This plugin works on Macmachines only.
Note: The Viz NLE for Final Cut plugin does not support Final Cut Pro X. Motion
(another application in Final Cut Studio) has known issues preventing it from being
fully supported (for details, see the Viz NLE 1.8 Release Notes).

Avid Media Composer and Avid NewsCutter
The Viz NLE for Avid plugin works together with Avid Media Composer and
NewsCutter. This plugin works on Windows-machines only, hence it does not
support Avid on Mac.
The Viz NLE for Avid plugin has been tested with Avid’s Media Composer and
NewsCutter; however, all systems supporting the Avid Extensions (AVX) 2.0
System Development Kit (SDK) should work. The following Avid products have
AVX2 support:
• Avid Digital Studio (DS)
• Media Composer (Older Release and Post Adrenaline HD release that can run
software only), Media Composer Adrenaline, and Media Composer Adrenaline
HD
• NewsCutter, NewsCutter FX, NewsCutter XP, and NewsCutter Adrenaline (FX)
• Symphony and Symphony Nitris
• Xpress, Xpress Pro, and Xpress Pro HD
Separate Viz NLE for Avid installers apply for Windows 32- and 64-bit systems.
The 32-bit Viz NLE version works together with Media Composer 5 and
NewsCutter 9, whereas the 64-bit version works with the new Media Composer 6
and NewsCutter 10.
Note: Avid Liquid, previously known as Pinnacle Liquid, has been discontinued by
Avid, and is currently not supported by Viz NLE.
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Quantel QEffects
The Viz NLE for Quantel plugin works together with Quantel QEffects 4.2 and
higher. This plugin works on Windows-machines only.
Note: Version 1.8 of the Viz NLE plugin is a complete re-write of the older Viz NLE
Plugin 1.3.4 for Quantel QEffects, which supported QEffects versions 3.6 to 4.1.

3.2

Hardware
Viz Engine basically needs a normal workstation with a decent graphics card such
as an NVIDIA Quadro 4000 or 5000. New in Viz NLE 1.8 when used with Viz
Connection Broker 1.1, is the ability to use two Viz Engines running as different
processes on the same computer, this requires two NVIDIA Quadro cards.
For detailed hardware requirements, refer to and compare relevant NLE system
requirements and Vizrt hardware requirements. In almost all cases the NLE system
requirements will suffice. See the Supported NLE Systems section for software
versions supported by the Viz NLE plugin.
For more information on other Vizrt products, and link to a complete list of
supported graphics cards, see the Related Documents section.

3.3

Network
A Viz Engine can be shared by multiple simultaneous NLE clients; however, there
are no recommended number of users for SD and HD as this in most cases is a
performance issue and not a fixed limitation.
The Windows and Mac-based NLE system setup typically operates on a single Viz
Engine. This requires transportation of frames (images) over the network, so a
fast network connection is recommended, preferably a gigabit switched network
connection; however, a megabit (100 Mbit/s) connection will also work as the
plugin supports lossless data compression using Portable Network Graphics (PNG)
or Run-length Encoding (RLE) instead of uncompressed raw images.
Note: RLE is only supported by Viz Engine 3.2.2 and later versions.

This section contains information on the following topics:
• Port Numbers
See Also
• Software versions
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3.3.1

Port Numbers
The table below describes all listeners, port numbers and which applications that
use the port numbers to establish a connection.
Table 1: Port numbers

Listener

Port

Description

Viz Engine

6100

Default port used for graphics rendering. Used by
the Viz Multiplexer to establish a connection to
Viz Engine.

Viz Trio

6210

Used by the Viz NLE plugin to establish a
connection to Viz Trio.

Newsroom
Component

6220

Used by the Viz NLE plugin to establish a
connection to VCP’s Newsroom Component.

Viz NLE Editor

6230

Used by the Viz NLE plugin to establish a
connection to the Viz NLE Editor.

Viz NLE Config

6240

Used by the Viz NLE plugin to establish a
connection to the Viz NLE Configuration tool.

Media Sequencer

8594

Port used by all clients that connect to the Media
Sequencer.

Viz Engine

14300

Alternative port used to avoid conflicts with port
6100 (e.g. using Viz Multiplexer). Port 6100 is
normally used by renderers that are on air, hence,
it is (e.g. when running Viz Content Pilot version
4) recommended to use another port.

Viz Engine
(multiplexed)

50007

Used by clients that connect to a multiplexed Viz
Engine.

50008
50009

50007: Isolated port. All connections to this port
get its own session. The port is used by Viz NLE
Plugin to deliver frames to the host NLE system.
For example rendering or scrubbing of video clips
with graphics. Using this port will also suppress
bounding box commands. Cannot be used by the
Newsroom Component.
50008: Shared port. All connections from one
single host shares one session. Used by Viz Trio
and Newsroom Component to display preview
frames.
50009: Fixed port. Same as shared port except
that allocated resources are never cleared from
memory. Used by VCP 4’s Newsroom Component.

Viz Connection
Broker

12

21098

Connection to the Viz Connection Broker
configuration interface (e.g. http://
localhost:21098/ ).
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Installation and Basic Configuration
The following sections describe the different setup procedures. The sections
follow the order of a new installation.
All installations use a Viz Engine in combination with a database. The “database”
is either a Media Sequencer, used by Viz Trio or Viz NLE Editor, or Viz Content
Pilot’s (VCP) database used by the Newsroom Component.
Figure 2: NLE systems using the Viz Connection Broker

The Viz Engine must handle multiple simultaneous requests. For Viz Engine
version 2.x this requires a separate installation of Viz Multiplexer; however, for
Viz Engine 3.x the multiplexing functionality is a built-in feature.
Note: The VCP workflow is only available to Windows-based NLE systems.

The Viz NLE plugin supports different NLE systems on both Windows and Mac,
and the setup is basically the same for both platforms. The Viz NLE Configuration
tool is used to configure the plugin, Viz Engine, the Media Sequencer and the
editor(s).
Viz NLE Editor for Mac supports browsing and previewing of Viz Trio templates
and pages stored on a Media Sequencer.
Viz Trio and VCP’s Newsroom Component both support browsing and previewing
of Viz Trio templates and pages stored on a Media Sequencer and templates and
data elements stored on the VCP database, respectively.
Note: NLE system-specific installations are outside the scope of this guide.

This section contains information on the following topics:
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•
•
•
•
•
•

4.1

Graphics Rendering
Viz Connection Broker
Mac-based Non-linear Editing Systems
Windows-based Non-linear Editing Systems
Upgrade from Viz NLE Plugin 1.3 to Later Versions for Avid upgrades
Testing the Installation

Graphics Rendering
To enable the NLE systems to render graphics, they must have a connection to a
Viz Engine.
For Viz Engine 2.x, rendering should be set to off-screen mode, and a Viz
Multiplexer must be installed in order to allow multiple simultaneous users. Viz
Multiplexer can be installed on the Viz Engine renderer machine or as a standalone server. In most cases the first option is chosen.
For Viz Engine 3.x, off-screen rendering is the default rendering mode. Viz
Multiplexer is also not needed as Viz 3.x has its own built-in multiplexing
functionality.
This section contains information on the following topics:
• To setup Viz Engine for graphics rendering
• To setup older versions of Viz Engine for graphics rendering
• To set Viz Engine 2 in off-screen mode
To setup Viz Engine for graphics rendering
• Start the installer and select VGA mode
To setup older versions of Viz Engine for graphics rendering
Note: This procedure is valid for Viz Engine up to version 3.2.x, including version
2.x.

1. Start the Viz Engine installation and extract the installation files. After the files
are extracted, cancel the rest of the installation.
Figure 3: Viz Engine manual installation using Command Prompt

2. Start the installation in manual mode.
• From a command-line tool open the viz3Install or VizInstall directory
14
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• Start the installation in manual mode and start the installation
Example: C:\viz3install\Setup.exe --manual
Figure 4: Viz Engine 2.x manual setup

3. Click the Standard-PC button to select a standard installation, and click Next
until the Setup Type window appears.
4. Select Typical installation and Finish the installation.
• For advanced users, choose Custom installation.
5. Install Viz Engine plugins that corresponds to the Viz Engine version and
plugins used by the scene designer.
To set Viz Engine 2 in off-screen mode
1. Start Viz Config (Viz Engine’s configuration tool).
2. Select Render-options, and set the Video Output Window option to Off Screen.
Note: Viz Engine 3 is by default configured to render in off-screen mode.
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4.2

Viz Connection Broker

Viz Connection Broker is a product that manages a pool of Viz Engines. Clients
can query it for a Viz Engine that matches a specific video mode. It provides load
balancing, video mode matching and can be used to create a redundant renderer
pool.
To install Viz Connection Broker
Note: The installation requires Microsoft .NET 4.0.

1.
2.
3.
4.

Double-click the Viz Connection Broker installer to start the installation.
Click Next, Next, and Install.
After the installation is done, click Finish.
From the Start menu, navigate to All Programs > vizrt > Viz Connection Broker
> Viz Connection Broker Web Interface.

The Viz Connection Broker’s web interface will open if the service is running
(address http://localhost:21098/).
Tip: It is possible to open the Viz Connection Broker web interface from other
machines. In order to do so, replace “localhost” with the actual hostname.

To add a Viz Engine
• Enter the Viz Engine hostname or IP address in the Configuration field, and
click Add Renderer.

16
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Note: If not specified, the Viz Engine will be added with default port 50007. When
using Viz Engines in a so-called dual channel setup, it is possible to run multiple
instances of Viz Engine on a single host. Each instance uses a unique port, which
means that two Viz Engines should only be considered duplicates when both the
hostnames and port numbers are identical. When referring to Viz Engines in a dual
channel setup, type the port number after the host name (for example
“VizEngine1:51007”).

To remove a Viz Engine
• Click the Delete button next to the Viz Engine entity that is to be removed.
Tip: Click the arrow next to the Viz Engine entity, or the Expand All link, to see
information on video mode, aspect ratio and Viz Graphic Hub connection.

To modify the ping interval towards a Viz Engine
1. Locate the Viz Connection Broker.exe.config file, typically located at
C:\Program Files (x86)\Vizrt\Viz Connection Broker.
2. In the config file, set a new value for the VizEnginePollIntervalMilliSeconds
option, which controls the interval for how often the Connection Broker will
poll each Viz Engine.
3. Set a new value for the VizEngineTimeoutMilliSeconds option, which controls
the timeout in milliseconds when trying to connect to a Viz Engine.
Code example:
<?xml version="1.0"?>
<configuration>
<configSections>
<sectionGroup name="applicationSettings"
type="System.Configuration.ApplicationSettingsGroup, System,
Version=4.0.0.0, Culture=neutral, PublicKeyToken=b77a5c561934e089" >
<section name="ConnectionBroker.Properties.Settings"
type="System.Configuration.ClientSettingsSection, System,
Version=4.0.0.0, Culture=neutral, PublicKeyToken=b77a5c561934e089"
requirePermission="false" />
</sectionGroup>
</configSections>
<system.serviceModel>
<services>
<service
behaviorConfiguration="ConnectionBroker.AtomBrokerService"
name="ConnectionBroker.AtomBrokerService">
</service>
</services>
<behaviors>
<serviceBehaviors>
<behavior name="ConnectionBroker.AtomBrokerService">
<serviceDebug includeExceptionDetailInFaults="true"
httpHelpPageEnabled="false" httpsHelpPageEnabled="false"/>
</behavior>
</serviceBehaviors>
</behaviors>
</system.serviceModel>
<startup><supportedRuntime version="v4.0"
sku=".NETFramework,Version=v4.0"/></startup><applicationSettings>
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<ConnectionBroker.Properties.Settings>
<setting name="VizEnginePollIntervalMilliSeconds"
serializeAs="String">
<value>10000</value>
</setting>
<setting name="VizEngineTimeoutMilliSeconds"
serializeAs="String">
<value>10000</value>
</setting>
</ConnectionBroker.Properties.Settings>
</applicationSettings>
</configuration>

4.3

Mac-based Non-linear Editing Systems
Using a Mac-based NLE system, such as Apple’s Final Cut Studio or Adobe’s
Premiere for Mac, requires an installation of the Viz NLE plugin. The Viz NLE
plugin installs the Viz NLE Configuration tool and the Viz NLE Editor.
Before installing the Viz NLE plugin, a Media Sequencer and a Viz Engine must be
running (on a Windows machine).
Note: Viz Engine and the Media Sequencer must both run on Windows XP. It is
recommended to run the Media Sequencer separately on a Windows Server 2008 or
Windows 7. In smaller production environments however, the Media Sequencer may
run on the Viz Engine machine.

The Media Sequencer should preferably contain a Viz Trio show to confirm that
the connection is working properly; however, the Viz NLE Editor has status
indicators indicating connections to Viz Engine, the host application (FCP or
Premiere for Mac) and the Media Sequencer which should be sufficient
information to confirm a correct setup.
This section contains information on the following topics:
•
•
•
•

4.3.1

Overview
Installation
Basic Configuration
Removal

Overview
The Viz NLE Editor is an editor tool that is used to fetch graphics content for use
with FCP or Premiere for Mac. Using the Viz NLE Editor enables Mac-users to use
graphics from Vizrt’s Windows-based Viz Engine and Media Sequencer.

18
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Figure 5: Basic setup

A basic setup requires a Viz Engine and a Media Sequencer, where the Media
Sequencer holds the actual data (for example text and image reference(s)) and Viz
Engine the graphic scenes. A prerequisite is that a Viz Trio operator has created a
show with graphics templates on the Media Sequencer. Once the show is available
on the Media Sequencer, the Viz NLE Editor is able to display the graphics such
that the NLE user can select and edit the content and add it to the timeline.
Figure 6: Advanced setup

A more advanced setup that uses Viz Connection Broker enables the Viz
Connection Broker to select engines from a pool of Viz Engines.
A typical setup using the Viz NLE Editor is as follows:
• NLE machines
• Mac-based NLE system (FCP or Premiere for Mac)
• Viz NLE plugin (with the Viz NLE Editor)
• Viz Engine
• Viz Graphic Hub (Viz 3.x) or local data root (Viz 2.x) with graphic scenes
• Extra Viz plugins for Viz Engine
• Viz Multiplexer for Viz Engine (Viz Engine 3.x has built-in multiplexing
functionalities whereas Viz Engine 2.x has not)
• Optional: Datapool plugins for Viz Engine
• Optional: Viz Connection Broker

Chapter 4: Installation and Basic Configuration

19

4.3.2

Installation
The following procedures install the Viz NLE plugins, which enable the use of the
Viz NLE configuration tools and the Viz NLE Editor.
Note: The installer requires an OSX user with administrator privileges.

• To install the Viz NLE for Adobe plugin on Mac
• To install the Viz NLE for Final Cut plugin
To install the Viz NLE for Adobe plugin on Mac
1. Double-click the disk image file (*.dmg) to open the package file.
2. Double-click the package file (*.pkg) to start the installation.
Figure 7: Viz NLE for Adobe installer

3. In the Viz NLE for Adobe installer, click Continue until the installation has finished.
4. Eject the file.
To install the Viz NLE for Final Cut plugin
1. Double-click the disk image file (*.dmg) to open the package file.
2. Double-click the package file (*.pkg) to start the installation.

20

Chapter 4: Installation and Basic Configuration

Figure 8: Viz NLE for Final Cut installer

3. In the Viz NLE for Final Cut installer, click Continue until the installation has
finished.
4. Eject the file.

4.3.3

Basic Configuration
This section explains the basic configuration of Adobe Premiere and Final Cut Pro
(FCP) when working with Viz NLE.
• Configuring Adobe Premiere
• Configuring Final Cut Pro
Configuring Adobe Premiere
For details on how to perform basic configuration changes, see To configure the
Viz NLE for Adobe plugin using Viz NLE Configuration tool. For details on
advanced configuration options, see the configuration tool’s tool tips or the
Configuration Interface section.
After the plugin has been configured the first time, the configuration can be
accessed in various ways:
• As a result of an error message, for example if the Viz Engine or Media
Sequencer is unavailable
• By clicking the Viz NLE Config button
• By selecting the Viz NLE Config option on the Viz NLE Editor menu. Optional:
Press the shortcut keys Command + , (comma).
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To configure the Viz NLE for Adobe plugin using Viz NLE Configuration tool
1. Start Adobe Premiere for Mac.
2. Open a project.
3. Add a Transparent Video clip to the project:
• In the Project panel, make sure that the Project tab is selected, and click the
New Item button in the lower right corner.
• From the menu that appears, click Transparent Video.
• In the New Transparent Video dialog box that opens, make sure the
resolution matches the current sequence settings, and then click OK.
• Drag the new transparent video clip to the Sequence panel.
4. Add the Viz NLE plugin to the project:
• In the Project panel, click the Effects tab.
• Navigate to Video Effects > Vizrt > Viz NLE Plugin, and drag the plugin onto
the transparent video clip in the Sequence panel.
5. Select the transparent video clip that holds the plugin.
6. Click the Effect Controls tab in the upper left corner.
7. Navigate to Viz NLE Plugin > Control, and click the Viz NLE Editor button that
appears.
8. From the dialog box that appears, click Configure.
The Viz NLE Configuration Tool then opens.
Figure 9: Viz NLE Configuration Tool

9. Make sure that the General tab is selected.
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10. Select a Viz Engine:
• Specific Viz Engine: Sets a Viz Engine connection.
• Viz Connection Broker: Sets a Viz Connection Broker connection.
11. Select a Media Sequencer.
12. Click the OK button to confirm the settings and close the configuration tool.
Configuring Final Cut Pro
For details on how to perform basic configuration changes, see To configure the
Viz NLE for Final Cut plugin using Viz NLE Configuration tool. For details on
advanced configuration options, see the configuration tool’s tool tips or the
Configuration Interface section.
After the plugin has been configured the first time, the configuration can be
accessed in various ways:
• As a result of an error message, for example if the Viz Engine or Media
Sequencer is unavailable
• By clicking the Viz NLE Config button
• By selecting the Viz NLE Config option on the Viz NLE Editor menu. Optional:
Press the shortcut keys Command + , (comma).
To configure the Viz NLE for Final Cut plugin using Viz NLE Configuration tool
1. Start Final Cut Pro.
2. Select the Effects tab in the Browser window, and add the Viz NLE Plugin effect
to the timeline.
Figure 10: Viz NLE Config button

3. Select the Controls tab and click the Viz NLE Config button.
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Figure 11: Viz NLE Configuration Tool

4. In the Viz NLE Configuration Tool that opens, select a Viz Engine.
• Viz Engine: Sets a Viz Engine connection.
• Viz Connection Broker: Sets a Viz Connection Broker connection.
5. Select a Media Sequencer.
6. Click the OK button to confirm the settings and close the configuration tool.
Note: If all connections are working properly, a list of Viz Trio shows from the Media
Sequencer should appear. Selecting a show will display all templates. Selecting a
template will display the tab-fields and preview the graphics.

4.3.4

Removal
The following procedures describe how to delete the Viz NLE plugins.
• To remove Viz NLE for Adobe on Mac
• To remove Viz NLE for Final Cut
To remove Viz NLE for Adobe on Mac
To remove the Viz NLE for Adobe plugin, use Finder, Terminal or some other tool
to remove the following files:
• /Library/Plug-ins/MediaCore/viznle_plugin.plugin
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• /Library/Application Support/Adobe/Common/Plug-ins/[CS version]/
MediaCore/viznle_plugin.plugin per installed CS version (for example CS5 and
CS6)
To remove Viz NLE for Final Cut
To remove the Viz NLE for Final Cut plugin, use Finder, Terminal or some other
tool to remove the following files:
• /Library/Plug-ins/FxPlug/viznle_plugin.fxplug
• /Library/Application Support/Final Cut Pro System Support/Plugins/
VizFcpNotifier.bundle
• /Library/Frameworks/VizCocoa.framework (used by older Viz NLE versions)

4.4

Windows-based Non-linear Editing Systems
Using a Windows-based NLE system, such as Avid’s Media Composer, Adobe’s
Premiere, or Quantel’s QEffects, requires an installation of the Viz NLE plugin. The
Viz NLE plugin installs the Viz NLE Configuration tool and an NLE version of Viz
Trio.
In order to configure the Viz NLE plugin for use, a Media Sequencer and a
multiplexed Viz Engine must be running.
Note: Viz Engine and the Media Sequencer both run on Windows XP. It is
recommended to run the Media Sequencer separately on a Windows Server 2008 or
Windows 7. In smaller production environments however, the Media Sequencer may
run on the Viz Engine machine.

This section contains information on the following topics:
•
•
•
•
•

4.4.1

Overview
Installation
Basic Configuration
Removal
Upgrade from Viz NLE Plugin 1.3 to Later Versions

Overview
Viz Trio is an advanced character generator that is used to produce content for
use with a Windows-based NLE system. Similar to the Viz NLE Editor, Viz Trio
basically requires a Viz Engine and a Media Sequencer.
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Figure 12: Windows-based NLE system using Viz Trio

A typical setup using Viz Trio is as follows:
• NLE machines
• NLE system
• Viz NLE plugin (includes bundled Viz Trio)
• Media Sequencer
• Viz Engine
• Viz Graphic Hub (Viz 3.x) or local data root (Viz 2.x) with graphic scenes
• Extra Viz plugins for Viz Engine (up to version 3.2)
• Viz Multiplexer for Viz Engine (up to version 2.8)
• Optional: Datapool plugins for Viz Engine
VCP’s Newsroom Component basically requires a Viz Engine and a VCP database.
The VCP database (Oracle 10g) is where the templates, template data elements
and its associated data is stored.
Figure 13: Windows-based NLE system using the Newsroom Component

A typical setup using VCP’s Newsroom Component is as follows:
• NLE machines
• NLE system
• Newsroom Component
• Viz NLE plugin
• Viz Content Pilot database installation
• Oracle 10g
• Viz Engine
• Viz Graphic Hub (Viz 3.x) or local data root (Viz 2.x) with graphic scenes
• Extra Viz plugins for Viz Engine (up to version 3.2)
• Viz Multiplexer for Viz Engine (up to version 2.8)
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• Optional: Datapool plugins for Viz Engine

4.4.2

Installation
The installer requires a Windows user with administrator privileges.
• To install Viz NLE for Adobe on a Windows machine
• To install Viz NLE for Avid
• To install Viz NLE for Quantel
To install Viz NLE for Adobe on a Windows machine
Note: Adobe Premiere (or Adobe AfterEffects) must be installed on the workstation
before installing the Viz NLE for Adobe plugin.

1. Double-click the Windows installer file (*.msi) to start the installation.
2. Click Next in the appearing Welcome dialog box.
3. Click Next in the Custom Setup dialog box.
• Optional: Select the features to be installed.
• Optional: Select a different installation location.
4. Click Install in the Ready to Install dialog box to start the installation.
5. Click Finish to end the installation process.
To install Viz NLE for Avid
Note: Separate installers apply for 32- and 64-bit NLE systems. The 32-bit installer
should be used together with Media Composer 5/NewsCutter 9 (or older), the 64-bit
installer with Media Composer 6/NewsCutter 10.

1. Double-click the Windows installer file (*.msi) to start the installation.
2. Click Next in the appearing Welcome dialog box.
3. Click Next in the Custom Setup dialog box.
• Optional: Select the features to be installed.
• Optional: Select a different installation location.
4. Click Install in the Ready to Install dialog box to start the installation.
5. Click Finish to end the installation process.
To install Viz NLE for Quantel
1. Double-click the Windows installer file (*.msi) to start the installation.
2. Click Next in the appearing Welcome dialog box.
3. Click Next in the Custom Setup dialog box.
• Optional: Select the features to be installed.
• Optional: Select a different installation location.
4. Click Install in the Ready to Install dialog box to start the installation.
5. Click Finish to end the installation process.

4.4.3

Basic Configuration
This section explains the basic configuration of a Viz NLE plugin for Windows.

Chapter 4: Installation and Basic Configuration

27

For Advanced configuration options, open the configuration tool and select the
Advanced tab. For more information about the Advanced options, see the Viz NLE
Configuration tool’s tool tips or the Configuration Interface section.
Configuration steps for the following plugins are described:
• To configure the Viz NLE for Adobe plugin using Viz NLE Configuration tool
• To configure the Viz NLE for Avid plugin using Viz NLE Configuration tool
• To configure the Viz NLE for Quantel plugin using Viz NLE Configuration tool
To configure the Viz NLE for Adobe plugin using Viz NLE Configuration tool
1. Start the NLE system; Adobe Premiere.
2. Open a project.
3. Add a Transparent Video clip to the project:
• In the Project panel, make sure that the Project tab is selected, and click the
New Item button in the lower right corner.
• From the menu that appears, click Transparent Video.
• In the New Transparent Video dialog box that opens, click OK.
• Drag the new transparent video clip to the Sequence panel.
4. Add the Viz NLE plugin to the project:
• In the Project panel, click the Effects tab.
• Navigate to Video Effects > Vizrt > Viz NLE Plugin, and drag the plugin onto
the transparent video clip in the Sequence panel.
5. Select the transparent video clip that holds the plugin.
6. Click the Effect Controls tab in the upper left corner.
7. Navigate to Viz NLE Plugin > Control, and click the Viz NLE Editor button that
appears.
8. From the dialog box that appears, click Configure.
The Viz NLE Configuration Tool then opens.
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Figure 14: Viz NLE Configuration Tool

9. Make sure that the General tab is selected.
10. Select a Viz Engine:
• Specific Viz Engine: Sets a Viz Engine connection.
• Viz Connection Broker: Sets a Viz Connection Broker connection.
11. Select a Media Sequencer.
12. Click OK to confirm the settings and close the configuration tool.
To configure the Viz NLE for Avid plugin using Viz NLE Configuration tool
1.
2.
3.
4.
5.
6.

Start the NLE system.
Create a new project and add a video clip to the timeline.
On the Tools menu select Effect Palette and Effect Editor.
In the Effect Palette, open the effect category named Vizrt.
Drag and drop the VizNlePlugin effect onto the timeline.
In the Effect Editor, click the Config button to open the Viz NLE Configuration
tool.
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Figure 15: Config button, Avid Media Composer 7.2

The Viz NLE Configuration Tool then opens.
Figure 16: Viz NLE Configuration Tool

7. Make sure that the General tab is selected.
8. Select a Viz Engine:
• Specific Viz Engine: Sets a Viz Engine connection.
• Viz Connection Broker: Sets a Viz Connection Broker connection.
9. Select a Media Sequencer.
10. Click OK to confirm the settings and close the configuration tool.
After the plugin is configured the first time, the configuration can be accessed by
clicking the Viz NLE plugin’s Config button in the Effect Editor window. The Editor
option is unavailable as long as no Viz Engine and Media Sequencer is configured
using the Viz NLE Configuration tool.
Note: If all connections are good, the Editor button will appear, making either Viz
Trio or the Newsroom Component available for use. For more information on how to
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configure Viz Trio and the Newsroom Component, read the Viz Trio and Viz Content
Pilot user guides, respectively.

To configure the Viz NLE for Quantel plugin using Viz NLE Configuration tool
1.
2.
3.
4.
5.
6.
7.

Start the NLE system; Quantel.
Add a clip to the timeline (the clip is added in layer 1).
Create a new layer (layer 2).
Make sure that the second layer is selected.
Make sure that the Effects tab is selected (lower left).
Click the Tracker > Qplugin button.
Click Favourites > Vizrt > VizNlePlugin.

The Viz NLE effect is then added to the second layer in the timeline.
8. In the Vizrt Editor that appears, click the Viz NLE Config button.
Figure 17: Quantel

The Viz NLE Configuration Tool then opens.
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Figure 18: Viz NLE Configuration Tool

9. Make sure that the General tab is selected.
10. Select a Viz Engine:
• Specific Viz Engine: Sets a Viz Engine connection.
• Viz Connection Broker: Sets a Viz Connection Broker connection.
11. Select a Media Sequencer.
12. Click OK to confirm the settings and close the configuration tool.

4.4.4

Removal
The Viz NLE plugin is removed using Windows’ Uninstall or change a program.
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Figure 19: Uninstall or change a program

• To remove Viz NLE for Adobe from a Windows machine
• To remove Viz NLE for Avid
• To remove Viz NLE for Quantel
To remove Viz NLE for Adobe from a Windows machine
1.
2.
3.
4.

Open Uninstall or change a program.
Select Vizrt Viz NLE plugin for Adobe.
Click Uninstall.
Click Yes in the appearing confirmation dialog box.

To remove Viz NLE for Avid
1.
2.
3.
4.

Open Uninstall or change a program.
Select Vizrt Viz NLE plugin for Avid.
Click Uninstall.
Click Yes in the appearing confirmation dialog box.

To remove Viz NLE for Quantel
1.
2.
3.
4.

4.4.5

Open Uninstall or change a program.
Select Vizrt Viz NLE plugin for Quantel.
Click Uninstall.
Click Yes in the appearing confirmation dialog box.

Upgrade from Viz NLE Plugin 1.3 to Later Versions
As the AVX1 effects are being phased out, newer versions the Viz NLE plugin has
been implemented for AVX2 to ensure that interoperability is secured for recent
and future Avid NLE versions.
Older versions of Avid NewsCutter and Media Composer supported only AVX1, as
did the corresponding version 1.3 of the Viz NLE plugin. More recent versions of
NewsCutter and Media Composer, such as NC 9 and MC 5, supported both AVX1
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and AVX2, and hence the Viz NLE plugin versions 1.5 and 1.7 also supported both
these formats. The new NewsCutter 10 and Media Composer 6, which
corresponds to Viz NLE version 1.8, support AVX2 only.
Since NewsCutter 10 and Media Composer 6 do not have support for AVX1,
migrating AVX1 material must be done before upgrading to these versions.
It is recommended to remove old NLE plugins before installing Viz NLE Plugin 1.5
or 1.7 for Avid, as the consequence of two differing systems on the same machine
is undefined. Recent official releases will be automatically removed.
All existing NLE systems need to be reconfigured due to new location and format
of configuration files. The configuration is now done after Avid is started. The
configuration for 1.5 and 1.7 is user-specific, whereas 1.3 (and older)
configuration was done for all users.
An upgrade from Viz NLE plugin 1.3 to 1.5 or 1.7 for Windows users is only
available to users of Avid NLE systems that support AVX2 effects. Loading
projects that use AVX1 effects will not work before the NLE system is updated to
use AVX2 effects.
This section contains information on the following topics:
•
•
•
•

Upgrading Effects in Avid NewsCutter and Others
To upgrade the Avid Media Composer 3.0 effect(s)
To upgrade Avid Media Composer 2.8 effect(s)
To upgrade effects in a transition period

Upgrading Effects in Avid NewsCutter and Others
Unfortunately many Avid NLE systems do not have the same support for
upgrading effects as recent Media Composer versions, so this procedure is more
cumbersome.
One problem is that to upgrade effects Avid also needs to have access to the old
effect, and if the old AVX1 effect exists on the system it will hide the AVX2 effect
in the effect library. This means that new AVX2 effects cannot be created directly,
and that new effects will be Viz NLE plugin 1.3 and AVX1 effects. Effects will then
have to be manually promoted.
As this is an unpractical situation, the Viz NLE plugin 1.5 and 1.7 installer will try
to remove any prior versions of the plugin it finds on the system. This is done to
ensure that the new plugin is used when creating a new effect, hence there is no
immediate way to upgrade the old effects to new effects.
Note: It is possible to upgrade old effects to the new plugin version, but the
procedure differs based on the Avid version used.

To upgrade the Avid Media Composer 3.0 effect(s)
Viz NLE plugins for Avid 1.5 or 1.7 must be installed, and versions prior to 1.5
and 1.7 must be removed, otherwise the following procedure will not work. If an
older version is not removed it will take precedence over later versions.
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1. Start Avid Media Composer 3.0.
2. In the Project window, go to the Settings tab and double-click on Effect Editor.
Figure 20: Effect Editor settings, Avid Media Composer 3.0

3. In the appearing dialog box, check the box labelled Automatically Promote
Missing AVX1 Effects.
• Optional: In Avid Media Composer 3.0 it is also possible to manually
upgrade an old effect by opening the Effect Editor for the effect and clicking
the Promote button.
4. Click OK, and restart the Avid system.
5. From then on, when you open a sequence with missing effects (that contains
old AVX1 effects), a dialog box will be displayed with the following message:

"This sequence contains missing AVX effects which will be promoted to
Advanced Keyframe AVX 2.0 effects. A copy of the sequence will be created
before it is updated."

6. Click OK.
• A backup copy of the sequence will be made, and the missing effects will be
promoted to AVX2.
Note: Old effects will not be accessible until the NLE system is updated.

To upgrade Avid Media Composer 2.8 effect(s)
Viz NLE plugins for Avid 1.5 or 1.7 must be installed, and versions prior to 1.5
and 1.7 must be removed, otherwise the following procedure will not work. If an
older version is not removed it will take precedence over later versions. Vizrt also
recommends upgrading Avid systems if conformation problems are experienced
with the current version.
1. Start Avid Media Composer 2.8.
2. After opening a bin, but before opening a sequence, type the following
command in the Avid console:
PromoteMissingAVXEffects
3. Open a sequence with AVX1 effect(s).
4. If there are any missing promotable AVX1 effects, a confirmation dialog box
will be displayed.
5. Click OK to promote the effect(s).
Note: This must be done for every project/bin that contains old effects.

To upgrade effects in a transition period
After a promotion, the NLE system will work exclusively with AVX2 effects. If other
projects needs to be upgraded just repeat the procedure.
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Vizrt strongly discourage doing anything else than promoting old effects while
both versions are installed. Editing should only be used with the new effects when
both are installed.
1. Remove the old plugin version.
2. Install Viz NLE plugin 1.5 or 1.7 for Avid.
3. Then install the latest 1.3 release of the plugin, which will use the old
configuration (INI) file right away.
4. Open a project with old effects.
5. For each effect, open the Effect Editor and click the promote/upgrade button.
Figure 21: Effect Editor, Avid Media Composer 2.7

6. Save the project.
7. Repeat steps 3 to 6 for similar projects.
8. Exit Avid, and remove the Viz NLE plugin 1.3 for Avid.

4.5

Testing the Installation
This section provides some basic system tests that can be performed to verify that
the Viz NLE plugin installation and setup is correct.
IMPORTANT! Make sure the Viz Engine and Media Sequencer or the VCP database is
connected.

This section contains information on the following topics:
• Final Cut Studio
• Avid Suites
See Also
• Supported NLE Systems

4.5.1

Final Cut Studio
This test assumes that the Viz NLE plugin is configured and ready to be tested.
To perform a test using Final Cut Studio
1.
2.
3.
4.

Start Final Cut Pro.
Import and add a video clip to the timeline.
Drag and drop the Viz NLE Plugin generator effect to the timeline.
Double-click the effect on the timeline to enable the effect controls in the
Viewer window.
5. Click the Viz NLE Editor button under the Controls tab, and the Viz NLE Editor
will be started.
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6. Edit and save a template.
7. When done, click OK.
8. Scrub the timeline to see the new effect.
9. Press Command + R to render the new effects.
10. Play the video clip to see the new effect.
See Also
• To configure the Viz NLE for Final Cut plugin using Viz NLE Configuration tool

4.5.2

Avid Suites
This test assumes that the Viz NLE plugin is configured and ready to be tested.
To perform the test using Avid Media Composer
1. Start Avid Media Composer.
2. Import and add a video clip to the timeline.
3. Drag and drop the VizNlePlugin effect from the Effect Palette onto the video
clip on the timeline.
4. Double-click the effect on the timeline to enable the Effect Editor.
5. Click the Editor button, and Viz Trio or Newsroom Component will be started.
6. Edit and save a template.
7. Scrub the timeline to see the new effect.
8. Click the render button in the Effect Editor to render the new effects.
9. Play the video clip to see the new effect.
See Also
• To configure the Viz NLE for Avid plugin using Viz NLE Configuration tool

Chapter 4: Installation and Basic Configuration

37

5

User Interface
This section describes the Viz NLE Editor and Viz NLE Configuration tool interface.
The configuration tool enables you to configure and tune the Viz NLE plugin while
using the NLE client.
All settings described in the following sections are valid for the latest version of
the Viz NLE plugin. For older versions, see available documentation for the
version in question. Example settings are given where it is needed to illustrate
how they are used.
This section contains information on the following topics:
• Editor Interface
• Configuration Interface
• Performance Tester Interface
See Also

• Viz Content Pilot User’s Guide
• Viz Trio User’s Guide

5.1

Editor Interface
This section describes the Viz NLE Editor’s interface (available for Mac users). If
you are using Windows with Viz Content Pilot’s Newsroom Component or Viz Trio,
please refer to the respective user guides.
This section contains information on the following topics:
• Menu Options
• Information Fields
• Preview
Menu Options
The following menu options are unique to the Viz NLE Editor. Other options are
generic options provided by the operating system.
• Page
• Save Page (Cmd+S): Saves a page back to the Media Sequencer.
• Next tabfield (Cmd + Arrow Down): Selects the next tabfield.
• Previous tabfield (Cmd + Arrow Up): Selects the previous tabfield.
• Show
• Import Trio XML Archive: Imports an exported Viz Trio archive. The import
recreates the exported show on the connected Media Sequencer.
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Note: When performing an import you should always make sure that the scenes are
available to the connected Viz Engine.

Information Fields
Viz NLE Editor supports the most common control properties; however, it is only
possible to input text, change numerical values, select images, geometries, fonts
and materials.
There is no support for input of boolean values, editing of lists and tables or
scrolls. However, the editor can use and render Viz Trio pages made using a
regular Viz Trio even though they have these field types.
Preview
The following may be set for the preview:
•
•
•
•

5.2

Safe area: Shows the defined safe area configured by the current Viz Engine.
Title area: Shows the defined title area configured by the current Viz Engine.
Key: Shows the graphics’ key signal.
Bounding boxes: Shows the bounding boxes for the graphical elements in the
scene.

Configuration Interface
This section describes the basic user interface that applies for the configuration
tool’s General and Advanced tab.
• Reset All: Resets all settings to default (factory settings).
• Performance: Opens the performance tester for Tuning the NLE System. See
also Performance Tester Interface.
• OK: Saves the current configuration.
• Cancel: Cancels all changes and closes the configuration tool.
• Help: Opens this guide in a browser.
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Figure 22: Important settings view, Viz NLE Configuration tool for Windows

Depicted above is the Windows-based configuration tool that describes the basic
settings needed to connect to a remote machine running a multiplexed Viz Engine
and a Media Sequencer as the “database”.
The following sub sections describe all user-configurable settings under the
configuration tool’s Advanced tab. The tables contain information about valid
values and what the settings are used for. Information about operating system
specific settings are noted in the Description column.
This section contains information on the following topics:
•
•
•
•
•
•
•
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5.2.1

Important Settings
The Important settings view displays the most important settings needed in order
to run the Viz NLE plugin.
Table 2: Important settings

5.2.2

Setting

Description

Viz Engine host

See the Viz Engine Settings section.

Use Viz Connection
Broker

Enables use of the Viz Connection broker, see Viz
Connection Broker.

Viz Connection Broker
host

Sets the host of the computer running the Viz
Connection Broker, see Viz Connection Broker.

Media Sequencer host

Sets the host of the computer running the Media
Sequencer service.

Plugin user interface

See the Plugin Settings section.

Viz Engine network
compression

See the Viz Engine Settings section.

Plugin Settings
The Plugin settings view displays all settings that are separate and only in use by
the Viz NLE plugin, hence they are not application specific settings such as Viz
Engine and Viz NLE Editor.
Table 3: Plugin settings

Setting

Description

Plugin color correction

Enables broadcast-safe colors.
Set cap-601 to cap high and low values directly to
get 16-235.
Set linear-cap-601 to perform a linear recalculation
of the data to 16-235.
Default value is None.

Plugin field dominance

In case the host application consistently reports a
wrong field dominance to the plugin, it is possible to
force the plugin to assume the field dominance which
is correct. It will not override the host application
when the host application states that there is no field
dominance, but will override it when it does.
Available options are: Autodetect (default), Lower
field first and Upper field first.
Limitation: Mac OS X only.

Plugin log directory

Use this setting to override the default logging
directory.
See the Log Files section for more information on
logging.
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Table 3: Plugin settings

Setting

Description

Plugin log level

Set the log level in order to provide an error report to
Vizrt. Set to "Report" the plugin will generate dated
log files. See the Log Files section for more
information on log file locations.
Only use it when it is specifically needed to make a
report as it will slow the effect of the plugin.
The default directory where logs are saved can be
overridden using the plugin log directory setting.
If set to None, the plugin will only log errors, which is
the default behavior.
If set to Report, the plugin will in almost all cases
include enough information in the log files to let
Vizrt figure out the cause of problems.
If set to Extreme, the plugin will generate a very large
amount of logging information.
Options: None, Report and Extreme.
Default value is None.

Plugin premultiply
alpha

Configures whether the plugin will pre-multiply
alpha or not when rendering. In some cases the Viz
Engine has already multiplied the color channels with
the alpha channel.

Plugin should log
fields/frames

Enables the plugin to dump all frames and fields it
renders to the file system allowing the user and Vizrt
support to identify issues related to the graphics.
Files are dumped in a sub directory below the "Plugin
log directory".

Plugin user interface

Sets the interface to use for selecting graphics
templates.
The plugin works with Viz Trio (default) and Viz
Content Pilot’s Newsroom Component.
A Viz Trio template and Newsroom Component
template that use the same scene, are two different
entities. Once an editor is set and used to add a
graphic effect to the timeline the effect is also bound
to that editor. To create an effect with a template
from another editor the old effect must first be
deleted, a new editor configured, and then a new
effect created.
Limitation: Windows only.
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5.2.3

Viz Engine Settings
The Viz Engine settings view displays all settings relevant for Viz Engine.
Table 4: Viz Engine settings

Setting

Description

Use Viz Connection
Broker

Enables the Viz NLE Plugin to connect to the Viz
Connection Broker for graphics rendering.

Viz Connection Broker
host

Sets the hostname or IP address of the Viz
Connection Broker (see Viz Connection Broker).

Viz Engine host

Sets the hostname or IP address of the Viz Engine
renderer.

Viz Engine network
cleanup

Sets the time for how long the plugin should wait
after last use before considering tidying up loose
connections to the Viz Engine.
Unless the actual use of the plugin has been
measured, this should not be changed.
Default value is 8m.

Viz Engine network
compression

Sets the compression to level.
No Compression for gigabit networks will send all
frames across the network uncompressed.
PNG (Portable Network Graphics) is a lossless
compression format.
RLE (Run-length Encoding) is a lossless compression
format. RLE is only supported by Viz Engine 3.2.2.
and later versions (see the Software section).
It is recommended to use no compression on gigabit
networks, and compressed formats on slower
networks (e.g. 100mbit).
Default value is RLE.

Viz Engine network
timeout

Sets the time for how long Viz Engine connections
should wait for replies.
Unless network measurements for the Viz Engine has
been performed, this setting should not be changed.
Default value is 45s.

Viz Engine prefetching

Prefetching, also known as caching, greatly increases
the rendering speed when using a start to stop
rendering, like Pinnacle's yellow slices, or Avid's prerender effect mode.
Failsafe mode is off.
Default value is on.
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Table 4: Viz Engine settings

Setting

Description

Viz Engine prefetch size

Use this setting to indicate how many frames or
fields the plugin should prefetch. A higher number
improves start to stop rendering (pre-render)
performance but reduces the scrub performance.
Note that this option is only available if prefetching is
enabled.
Default value is 20.

5.2.4

Editor Settings
The different editor settings views display all settings relevant for either Viz NLE
Editor, Viz Trio or the Newsroom Component. Limitations are noted.
Table 5: NLE editor settings

Setting

Description

Drive remappings

Semicolon-separated list of drive remappings used
during import of Viz Trio shows. These will cause
associated files of the specified file types to be
unpacked to a different drive letter than stored in the
*.trioshow file. Each mapping is on the form
wildcard=driveletter.
Limitation: Only used by Viz Trio.

Executable

Name of the editor's executable file. Can be changed
in case another filename is in use than the usual.
Default values are trionle.exe or VcpAxNle.exe.
Limitation: Windows only.

Grace period

Sets the time for how long the plugin should give Viz
NLE Editor to start everything without interruptions.
Default time is 2s.

Network timeout

Sets the time for how long connections to Viz NLE
Editor should wait for replies.
Unless network data for the Viz NLE Editor has been
measured this should not be changed.
Default value is 90s.

VOS image search

URI template for image search from Viz Object Store,
a component of Viz Content Pilot. This requires the
VCP Data Server, introduced in VCP 5.6. Being a URI
template means there should be a placeholder in the
text you enter, indicated by curly-brackets, which
gets replaced by specific search terms, as in this
example: http://vcpserver.example:8177/vos/
search?q={query}.
Limitation: Mac only.
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Table 5: NLE editor settings

Setting

Description

Options

The exact command line option(s) string that should
be passed to the editor’s process at startup.
For more information on command line options, see
the Options section.
Limitation: Only used by Viz Trio and Newsroom
Component.

Shared folder

Shared path used for temporary files during import
of Viz Trio shows. Both the NLE plugin and the
external Viz Engine should have full access to this
folder.
Limitation: Only used by Viz Trio.

Shared folder for Viz
Engine

Shared path as seen from the Viz Engine machine,
must refer to the previous setting. Only needed if the
external Viz Engine uses a different path (e.g
mapped network drive) for the same folder.
Limitation: Only used by Viz Trio.

5.2.5

VOS Image Search
When using the Viz NLE for Final Cut plugin, it is possible to set up a Viz Object
Store image search, provided that an app server is set up.
To perform a VOS image search
1.
2.
3.
4.
5.

Create a sequence.
Add a clip to the sequence.
Drag the Viz NLE effect to the sequence.
Double-click the effect, and select the Controls tab at the top of the screen.
From the Controls panel, click the Viz NLE Config button.
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6. In the Viz NLE Configuration Tool window that opens, click the Advanced tab.
7. From the Settings view list, click All settings.
8. Locate the VOS image search, and set the path to your Viz Object Store.
9. Click the OK button.
10. Back in the Controls panel, click the Viz NLE Editor button.
11. In the Viz NLE Editor window that opens, select a show and then a template
containing an image field.
12. From the Information fields list, select the field that contains the image.
13. From the window that opens, click the Search tab.
14. Type a search string that matches your preferences in the search field.
15. From the list of images on your app server, select the one you prefer.
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16. The image is being updated both as a thumbnail in the Information fields list,
and in the preview window.
17. Click the OK button to return to the sequence view.

5.2.6

Options
Options are used as variables for the actual value set for the plugin. The options
can be used as part of an editor’s startup options.
The following options are available and configurable:
• MSE_HOST: References the active Media Sequencer host.
• Example: -mse MSE_HOST
• LOG_PATH: Refers to the currently used Plugin log directory.
• Example: -logfile-path "LOG_PATH"
Note: The startup options are only valid for NLE editors on Windows.

See Also
• Options setting

5.2.7

Shared Settings
This section covers the shared settings feature that is available to Windows users
in the system registry.
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Figure 23: SettingsDir, Shared Viz NLE settings

Whereas the Viz NLE 1.3 setup file had a static placement for example under
C:\Program Files\, the new system stores the settings in a per-user directory,
for example under C:\Documents and Settings\<username>\. Placing the
same file in a shared directory allows multiple users to use a standardized setup
overriding per-user settings.
Note: The shared setting does not apply for Mac users.

By adding a Windows registry entry with a path to the master configuration file,
the settings in that file will take precedence over the default values for the various
settings, but the individual settings that the user changes in the Viz NLE
Configuration tool will take precedence over the master configuration file.
HKEY_LOCAL_MACHINE/SOFTWARE/[vizrt]/NLE/AVX2/SettingsDir

Given a particular setting, the following rules apply:
1. If a setting has been set using the Viz NLE Configuration tool, that value is
used, otherwise
2. if it has a value in the master configuration file, that value is used, otherwise
3. the default value for the setting is used.
To add a shared setting
1.
2.
3.
4.
5.
6.

5.3

Start Viz NLE Configuration tool.
Configure the Viz NLE Plugin using the configuration tool.
Save and exit the configuration tool.
Find the file vizplugin.xml in the current user's Application Data folder.
Copy the file to the designated shared location.
Set up the SettingsDir registry entry to point to the shared directory location
where the copied file was placed.

Performance Tester Interface
With the Viz NLE Plugin for Mac and Windows there is a small performance tester
tool available for testing various configurations. The tool will test the plugin
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directly and how it performs on the network and how quickly it returns graphics
to the NLE system.
It will not test the time it takes to fill the NLE system's frame buffer or the time the
NLE system uses between each request for frames to the NLE system. Hence, it is
recommended to test the NLE system once the Viz NLE Plugin is tested and found
to be working satisfactory.
Figure 24: Viz NLE Performance Tester on Mac.

The performance tester tool tests the rendering, network speed and how long it
takes before the plugin delivers a frame to the NLE system, that is the raw speed
of the plugin.
• Results table: Shows a table of results displaying the protocol tested, prefetch
size, time and frames per second (fps) achieved.
• Viz Engine: Sets the Viz Engine host to be used for testing.
• Image Protocol: Sets the parameter for how to transfer the graphics over the
network. Select one or multiple options.
• Prefetch size: Sets the prefetching that will be tested. Available options are 5,
10 or 20 frames or fields.
• Scene name: Sets a particular scene that can be loaded and tested (e.g.
02_GFX/VizNLE/1000).
• Clip length: Sets the length of the clip that is to be rendered. 5 or 10 seconds
are good starting points to check the rendering time.
• Pause time: Sets the pause in milliseconds between renders, that is the time
that an NLE system uses to process the previous data. This would be set much
lower for SD than for HD. It is recommended to try other values between 0 and
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100 ms+ to see how this affects the network use. For more information, see
the Tuning the NLE System section.
• Run tests: Tests the current settings configured for the plugin with the clip
length and pause options set. This is useful when performing tests with
concurrent users.
• Test summary: Shows a report of problems and various statistics.
Once the settings that give the optimal results are found they can be set in the Viz
Configuration Tool manually such that the settings can be tested with the actual
NLE system as well.
See Also
• Tuning the NLE System
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Tuning the NLE System
The Viz NLE Plugin is a fairly complex product that involves several applications
communicating over a network. These applications need to be individually robust
and the communication between them equally robust.
The first step of any installation is to see that everything works fine; hence, the
plugin will in most cases work out of the box. After everything is working, the
next step is to configure it to work reliably in the work environment it is used
which for many is a non-trivial task.
This section contains information on the following topics:
•
•
•
•
•

Overview
Compression
Prefetching
Concurrent users
NLE System Processing

See Also
• Performance Tester Interface

6.1

Overview
Viz NLE is designed to give the NLE system direct access to preview, edit and
apply graphics to the NLE project and consequently onto the video on the
timeline. In addition Viz NLE is designed around the concept of one renderer
being shared by several concurrent users on a fast network. The complexities of
this design is hidden from the normal user and to a certain extent to the system
administrator. Hence, there are multiple challenges with this approach when
effects are rendered.
The following can be described as a common workflow for most NLE systems:
• The NLE system (Final Cut Pro, Avid Media Composer and others) demands a
frame or field from the Viz NLE Plugin.
• The Viz NLE Plugin checks its configuration and tries to connect to Viz Engine
over the network.
• When connected, the plugin will query Viz Engine for basic information, load
the graphical scene in question and set the correct values in the scene, and
stretch the graphics to fit the effect in the NLE project.
• The plugin will then start requesting fields and frames from Viz Engine
depending on what the NLE system has requested.
• Viz Engine will receive the requests and ensure that the right scene is loaded
and move to the right frame or field and grab the graphics and send them
back over the network.
• Viz NLE plugin will receive the graphics and hand them back to the NLE
system.
• The NLE system will process the data it received before requesting more
graphics, thus repeating the steps above.
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The procedure described above is simple to follow, it works fine and is easy to
test. The problem with it is that it is not very fast. The most obvious problem is
that NLE systems ask for a simple frame or field at a time and blocks until it gets
a reply. The Viz NLE Plugin sends the request to Viz Engine and has to wait for a
reply before it replies back to the NLE system.
The first concern is the amount of data being sent, for example a simple
interlaced HD (1080i) field with full alpha is 4MB (1920*540*4 bytes) in size which
will take some time to transmit. To render a 5 second interlaced HD clip at 50
frames a second means that more than a gigabyte of raw data has to be rendered
and then processed by Viz Engine, sent over the network, received by the Viz NLE
Plugin, and then moved into the buffers provided by the NLE system whereupon
the NLE system needs to process the gigabyte of data.
Every network also has latency and is affected by other traffic on the network.
Waiting for every request returning with 4MB of graphic will take time, and then
waiting for the NLE system to process it further also means that there is a lot of
inactivity. Therefore, the Viz NLE Plugin has a goal of whenever the NLE system
asks for a frame or a field it will have it ready to cut the delay. The plugin tries to
accomplish this by keeping the network and Viz Engine continuously busy. It will
try to predict what the NLE system will ask for next by asking Viz Engine in
advance for graphics. Once Viz Engine has received the request it will render the
graphics, have it sent back to the plugin which will process it to fit the format of
the NLE system and have it ready.
To keep this workflow going there are a number of factors affecting it:
• What tv-standard to use, for example PAL is a lot smaller than 1080i and will
be quicker to render, process and send over the network.
• The CPU and GPU of the Viz Engine defines how fast it can deliver graphics. As
always, a better graphics card, faster CPU and more memory will help.
• The network card on Viz Engine and the NLE client machine.
• The network capacity defines how much data can be sent over the network.
• The compression of the data decides both how much CPU is used on Viz
Engine to compress and on the client to uncompress, as well as how much
data is sent over the network.
• The amount of ask-in-advance requests keeping the renderer and the
network busy.
• The processing the NLE system needs to do with the data it receives (affected
by CPU and/or GPU, memory, software and so on).
Some things can be improved by adding hardware to the renderer and the clients,
and by using as fast a network as possible. Other things, such as Compression,
Prefetching and Concurrent users, can be configured, either by the plugin or by
convention. In addition the processing done by the NLE system will have a great
impact on the performance as well.
See Also
• NLE System Processing
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6.2

Compression
Currently the Viz NLE Plugin supports two different types of compression as well
as sending uncompressed data.
The following options are available:
• No compression (raw)
• Benefit: No CPU spent on the renderer to compress and no CPU spent on the
client to decompress. Usually very good for SD on good networks. Very
good on clients with weak CPU and a good network card.
• Problems: For HD the amount of data is large, and it will typically take
longer to transfer over the network than compressed alternatives and it will
use a lot of network capacity.
• Portable Network Graphics compression (PNG)
• Benefit: Compresses graphics very well. On very slow networks this
compression will have a very small footprint, which is useful for example
over a Digital Subscriber Line (DSL) network, 10Mbit networks or district
offices rendering on a renderer in a central office.
• Problems: Can use a lot of CPU to compress and decompress, which will be
a problem on slower computers. Generally outperformed by the other two
options and mostly useful for special cases.
• Run-length Encoding compression (RLE)
• Benefit: Compresses graphics well. Is easy and fast to compress and
decompress. Uses a small fraction of the space for a 1080i field compared
to no compression so network footprint is quite good. For HD on fairly
updated computers it will often perform best. Also does very well on
100Mbit networks. Has special handling that exploits the nature of TVgraphics and NLE graphics which contain bigger open areas, for example
lower thirds, over the shoulders, and so on.
• Problems: Uses CPU on the renderer and the client, so less powerful
machines might get better performance with no compression. The smaller
amounts of data with SD negates some of the compression benefits, but can
often be best for SD too. Might not give much benefit if there are big
horizontal gradients.
Experience when testing in a lab has shown that the general advice above will not
always hold, and only on site testing will tell what works best for a given network.

6.3

Prefetching
As explained, in the Compression section, the Viz NLE Plugin will try to guess
what the NLE system will ask for next and ask for the frames and fields from the
renderer in advance. It is possible to disable this feature but this will be the safe
mode described earlier and is only for use if there are problems with the
prefetching.
When tuning the performance the question is how aggressive the prefetching
should be. The current releases uses more aggressive prefetching than earlier, so
the key thing now is to configure how many fields to prefetch, that is how many
graphics requests should be on the network from one client at any given moment.
It is also an option to ask the system to prefetch the whole clip, and it would
probably give an ok performance; however, this will block the Viz Engine for other
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users who want to edit their effects, scrub the timeline or render. In general the
default setting of prefetching 20 fields is a good compromise, but the setup
might require a different value and anything between 5 and 30 are ok values.
See Also
• Compression

6.4

Concurrent users
Viz NLE Plugin has been designed for several users editing, scrubbing the timeline
and rendering at the same time. And the users should have a responsive system
and they all need to have their own state on the Viz Engine. This is accomplished
by the Viz Multiplexer for Viz Engine 2.8, while Viz Engine 3 has its own built-in
multiplexer.
When tuning performance it is important to take into account that testing on a
single machine will not give the full answer as to how it will be when all machines
are working at the same time. In a video editing environment one can also assume
that big video files are also transferred over the network taking up a certain
amount of the network capacity. The Performance Tester will only test speed for
one user, so the real test is to test with several users after things are ok for a
single user.
See Also
• Performance Tester Interface

6.5

NLE System Processing
One thing that we have seen is that despite an optimally configured NLE plugin,
users still might have performance problems. One important factor is the size of
the project. One can safely assume that working on a fully interlaced HD (1080i)
project will use more resources than PAL or NTSC.
When there is a mismatch between video size and the timeline/project settings,
the NLE system might need to rescale graphics and video which is a costly
process. Rendering on a video that resides on a shared drive on the network will
also steal valuable network capacity.
Consider the following case; An interlaced HD project with a well-configured Viz
NLE Plugin has an effect added to a layer above the video, and rendering is
started. The following will happen;
1. The NLE system asks for a frame,
2. receives it from the Viz NLE Plugin,
3. and processes the graphics and possibly caches the data on disk.
These steps will then be repeated for each frame. Steps 1 to 2 might only take 20
milliseconds (ms); however, the time from 2 to 3 can be as much as 600-1000
ms. So ensuring that the video size, format, project, and timeline settings
correspond with each other, and that rendering is done locally on a fast disk helps
a lot. Although the performance analysis reports all things as good, the system as
a whole might be slow due to slow hardware on the NLE system.
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Troubleshooting, Logging and Reporting
The following sub sections describe how to report problems to Vizrt, how to log
Viz NLE plugin activities and lastly a section on common questions and answers.
This section contains information on the following topics:
• Reporting Problems
• Log Files
• Questions and Answers

7.1

Reporting Problems
Viz NLE is (despite the simple interface) a complex integration of several products
with a number of things that can go wrong. Viz NLE is hiding most of this
complexity for the users and to a certain extent also to people who set things up.
When there is a problem it might be hard to provide the right information to Vizrt
Support in order to track down the problems. This section is a step-by-step guide
for how to report problems.
Note: All problems should be registered with Vizrt’s Customer Portal, or if your
company does not have access to the portal a report should be sent to a local Vizrt
representative or directly to support@vizrt.com.

This section contains information on the following topics:
• Before Reporting Problems
• Reporting a Problem

7.1.1

Before Reporting Problems
• Read the Viz NLE Administrator's Guide
• Read the Viz NLE Release Notes
• Check that things were configured the way they were meant to
Note: Check that the hardware specified and the tested and recommended versions
of Viz Engine and Viz Multiplexer is used.

Note: The plugin depends very much on the Viz Engine being configured for it;
hence, it should only be used by NLE users.

7.1.2

Reporting a Problem
When filling out a report please add as much information as possible. All reports
should ideally contain what is described in the Content of the Report section, and
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in addition logs and information about how to reproduce the problem for the
specific Viz NLE plugin installed.
This section contains information on the following topics:
• Content of the Report
• To make a report for Viz NLE Plugin using Avid Media Composer
• To make a report for Viz NLE Plugin using Fincal Cut Pro
Content of the Report
The report should contain information about the following topics; Problem
description (as detailed as possible), logs, software and hardware, setup, graphics
and network.
See the following sections on how to make reports for different versions of the Viz
NLE plugin.
• Problem description: Include a good description of what the problem is and
how to reproduce it. Remember to use simple English.
• Discern different components, for example when clicking Edit in the NLE
system an editor is started (Viz Trio, Viz NLE Editor for Mac and so on).
• Add screen shots and illustrations that will simplify the message.
• Logs: Create a log where the problem, and only the problem, has been
reproduced. This is essential for tracking down things and ruling out
problems. For more information, see the Log Files section.
• Software and Hardware: Add exact versions of software (build number) and
hardware used.
• Viz NLE plugin (installer) as well as system type (Mac/Windows versions) it is
installed on (including hardware and important service packs)
• Viz Engine (and hardware, if it is a standard PC or has SDI)
• Viz Multiplexer (Viz 2.x users) and any special configuration
• NLE system used, and information about project settings, as well as any
special things in the project that might make sense (GPU effects, transition
effects, video size not same as project setting, and so on.)
• Editor used, for example VCP's Newsroom Component, Viz Trio or Viz NLE
Editor.
• Setup: Describe differences in the installation, if any, from the recommended
setup.
• Graphics: Include scenes that work and do not work, and add information
about what has been tested (for example if key is ok or not).
Note: The Viz NLE plugin does not support Transition Logic scenes.

• Network: Add a description of how the network, bandwidth, routers, and
switches are configured.
To make a report for Viz NLE Plugin using Avid Media Composer
1. Start Avid.
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Figure 25: Config button, Effect Editor in Avid Media Composer

2. Click Config on a Viz NLE plugin effect.
Figure 26: Viz NLE Configuration Tool for Windows, Plugin settings

3.
4.
5.
6.

Go to Plugin settings and find Plugin log level, and set it to Report.
Close the configuration tool.
Close Avid.
Open Windows Explorer at the default Viz NLE log directory.

Note: The default Viz NLE log directory is %APPDATA%/Vizrt/VizNLE/Logs. The log
directory can be modified from the Viz NLE Configuration Tool for Windows, Plugin
settings.

7. Move all log files to a new directory. The log folder should be empty.
8. Start Avid and reproduce the problem.
9. Close Avid after reproducing the problem.
10. Store the files that were created in %APPDATA%/Vizrt/VizNLE/Logs
somewhere safe and attach them to the appropriate support case.
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To make a report for Viz NLE Plugin using Fincal Cut Pro
1. Start FCP.
Figure 27: Viz NLE Config, Controls in Final Cut Pro

2. Click Viz NLE Config on a Viz NLE plugin effect.
Figure 28: Plugin debug level, Viz NLE Config for Mac

3. Go to plugin settings and find logging, and set it to Report.
4. Close the configuration tool.
5. Close Final Cut Pro.
6. Open Finder at Home > Library > Logs > VizNLE.
7. Move all files to a new directory. The log folder should be empty.
8. Start FCP and reproduce the problem.
9. Close FCP after reproducing the problem.
10. Store the files that were created in Home > Library > Logs > VizNLE
somewhere safe and attach them to the appropriate support case.
See Also
• Log Files

7.2

Log Files
Logging is performed by the Viz NLE plugin, and the different applications that
the Viz NLE plugin integrates with. The following paragraphs describe the
different log files, their log levels, and where they are stored.
The Viz NLE plugin generates log files that are located in the directory specified
by the Viz NLE plugin (see below).
The Windows-based log files are placed in the following directory;
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• %APPDATA%/Vizrt/VizNLE/Logs
• viznle-log-<date_time>.txt
• nleconfig-<date_time>.txt
• vcp_ax_nle.log
• trio-<date_time>.log
Note: The log directory can be modified from the Viz NLE Configuration Tool for
Windows, Plugin settings.

The Mac-based log files are placed in the following directory;
• ~/Library/Logs/VizNLE/
• viznle_log--<date_time>.txt
• VizNLEConfig--<date_time>.log
• VizNLE_Editor--<date_time>.log
The Viz NLE related log files, including Viz Trio and Newsroom Component log
files, are by default placed at %APPDATA%/Vizrt/VizNLE/Logs.
Figure 29: Plugin log directory

The location of the Viz NLE log files can be modified from the Viz NLE
Configuration Tool, under the Plugin settings view. The text in the Plugin log
directory box defines the folder where the log files should be placed. To define a
new folder for the log files, type a new path in the text box.
The path for the Viz Trio and Newsroom Component log files can be modified
from the Viz NLE Configuration Tool, under the Viz Trio NLE andNLE Newsroom
Component settings view respectively. By default, these log files are defined to be
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put in the same folder as the Viz NLE specific log files, by using the -logfilepath LOG_PATH command in the options text box (LOG_PATH refers to the Plugin
log directory setting).
Figure 30: Example, Viz Trio log files in default Viz NLE log folder

To place the Viz Trio and Newsroom Component log files in a folder separate
from the NLE log files, replace LOG_PATH in the options text box with a folder
name.
Note: Plugin log directory does not apply for Viz NLE Editor.

See Also
• NLE editor settings
• Plugin settings

7.3

Questions and Answers
This section contains a mix of troubleshoot and frequently asked questions, and
will try to answer questions that may arise when using the Viz NLE plugin.
Differences between the Mac and Windows-based versions are noted where
needed.
This section contains information on the following topics:
•
•
•
•
•
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General
Using the NLE System
Configuring the NLE System
Tuning the NLE System
Rendering with Viz Engine
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• Configuring Graphics Cards

7.3.1

General
• How do I contact Vizrt with my NLE questions?
• Before a question is forwarded, please read the questions and answers that
are given in the sections below. For problem reporting, see the Reporting
Problems section.
• Does the Viz NLE plugin support sound?
• No. Sound used with graphics is based on the timeline used for the
graphics, and there is no good and general way of stretching sound.
• Why are my start, stop and continue buttons in Viz Trio disabled?
• When using an external Viz Engine with a Viz Multiplexer, the start, stop
and continue buttons in Viz Trio are disabled. This is the same for the
Restart Viz Engine option that is available from the conetxt menu in the
Render window.

7.3.2

Using the NLE System
• Which video editing software works with the Viz NLE plugin?
• See the Supported NLE Systems section.
• Can I control several stop points?
• Viz NLE plugin does not support control of multiple stop points.
• How do I get animations to keep on going when the effect is stretched?
• Animations in other directors than the root director (first) are not stretched.
• Why am I seeing double-sized graphics?
• There is a difference between broadcast and consumer resolution. Several
of the plugins are confused by for example consumer HD, producing
graphics of the wrong sizes. If the camera says 1080i and has a resolution
of 1440x1080 or 1280x1080 it is consumer HD as opposed to broadcast
HD of 1920x1080.
• Check that the software versions are correct. For details, see the
Requirements and Recommendations section.
• My effect has an in-animation of 3 seconds and an out-animation of 4
seconds, what will happen to my effect if I shorten or stretch the animation?
• If a 7 seconds animation is shortened to 5 seconds it will show the inanimation of 3 seconds and cut the out-animation down to 2 seconds.
• If a 7 seconds animation is stretched to 10 seconds it will show the inanimation of 3 seconds, stretch the stop point between the in and outanimation to 3 seconds, and show the out-animation of 4 seconds, totalling
to 10 seconds.
• I have edited and saved a scene but I cannot see the graphics on the video.
Why is this?
• When editing a scene in Viz Trio, Newsroom Component or the Viz NLE
Editor select to see the scene with “key” turned on (available above the
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renderer window). If the scene goes black, there is a design flaw in the
scene. Redesign the scene by adding key to it.
• Viz 2.x: If the key is correct and still there are no graphics, try the following;
Start Viz Config and activate Off-Screen Graphics Rendering. Restart Viz
Engine and open the Viz Engine console window. If the following is
observed, then Viz Engine is unable to initialize the off-screen render
buffer. This might be caused by a wrong driver version, or an unsupported
graphics card.
Entering Main Loop...
Unable to create pbuffer (wglCreatePbufferARB failed)
Pbuffer: create context failed.
FATAL ERROR: could not make current during initialize

• Why does the preview in Newsroom Component only display VPreviewPanel?
• This might be a network bandwidth problem. In most cases this happens
when the Viz NLE plugin’s compression is set to No Compression and there
is a bandwidth mismatch between Viz Engine and the NLE machine. Usually
this happens when for example the NLE machine is connected to a 1Gbps
network and the Viz Engine is connected to a 100Mbps network.
• Try to set compression to PNG Compression or configure both machines to
use the same network with the same bandwidth. Remember to check that
the network cards are compatible with the network it is connected to.
• Viz Engine should ideally be connected to a fast network. If the NLE machine
is connected to a slower network it should work fine.
Note: Recommended bandwidth for No Compression is 1Gbps.

• How do I set the Newsroom Component’s preview aspect ratio?
• The preview aspect ratio is set in Viz Config’s Output Format section (Viz
Engine’s configuration tool).
• Why is Avid locked while using the Viz NLE Plugin?
• The architecture of Avid and most NLE systems is that they block whenever
a plugin is executing, which includes when the user has pressed Edit, the
editor is open and the plugin is waiting for a response.
• Why are the Viz NLE editors and configuration programs not closed when the
NLE system is closed?
• The NLE system is unable to handle a shutdown of the plugin itself (see
previous question).
• If the NLE system is accidentally terminated or closed this might cause the
plugin process to still be running, and a manual and forced shutdown of the
plugin is necessary. The latter can be obtained by restarting Avid or using
the Task Manager.

7.3.3

Configuring the NLE System
• Which ports are used in a typical installation?
• See Port numbers.
• On a Windows system, how do I configure the Viz Engine host and port?
• For details about installing Viz Engine, see the Graphics Rendering section.
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• On a Windows system, how do I configure the output from the Viz Engine?
• Some settings related to the output from the Viz Engine are configurable.
For example the image compression protocol (No, PNG or RLE).
• If some of the Viz Engine settings are incorrect the preview will be disabled,
and a message giving the reason will be displayed. Cases can be if the host
is not found, cannot connect to the port, and so on. In addition if the Viz
Engine connection is lost during runtime, the user will be notified.
Note: Some GUI settings are only valid for Windows-based NLE integrations using
Viz Trio and the Newsroom Component.

• On a Windows system, how do I configure the user interface that the Viz NLE
plugin should use?
• Open the Viz NLE plugin configuration tool and set the Plugin user interface
setting and set it to Newsroom Component or Viz Trio.
• The setting ensures that the NLE application will send the extra data that the
user interface needs. This includes, but is not limited to, the scene length in
milliseconds.
• All user interfaces will show an error message in case the NLE system is not
configured properly. The log files will also show warnings for non-critical
problems.
See Also
• Graphics Rendering
• Port numbers

7.3.4

Tuning the NLE System
• How can I find out how much time is used between each call from the NLE
system to the plugin?
• Empty the log directory, and start a project, make an effect, render it and
exit the NLE system. Go to the log directory (see the Log Files section) and
run the following command:
grep --binary-files=text PERFORMANCE viznle-log*.txt

• Disregard the first few numbers and you might find for example:
14:42:03 [T:2689318816] [/Users/<username>/fcp-1.0/plugins/fcp/
VizNlePlugin.mm,876] QUEUE PERFORMANCE: Time between renders 397
msecs.
14:42:03 [T:2689318816] [/Users/<username>/fcp-1.0/plugins/fcp/
VizNlePlugin.mm,876] QUEUE PERFORMANCE: Time between renders 170
msecs.
14:42:03 [T:2689318816] [/Users/<username>/fcp-1.0/plugins/fcp/
VizNlePlugin.mm,876] QUEUE PERFORMANCE: Time between renders 394
msecs.
14:42:04 [T:2689318816] [/Users/<username>/fcp-1.0/plugins/fcp/
VizNlePlugin.mm,876] QUEUE PERFORMANCE: Time between renders 161
msecs.
14:42:04 [T:2689318816] [/Users/<username>/fcp-1.0/plugins/fcp/
VizNlePlugin.mm,876] QUEUE PERFORMANCE: Time between renders 157
msecs.
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14:42:04 [T:2689318816] [/Users/<username>/fcp-1.0/plugins/fcp/
VizNlePlugin.mm,876] QUEUE PERFORMANCE: Time between renders 411
msecs.
14:42:04 [T:2689318816] [/Users/<username>/fcp-1.0/plugins/fcp/
VizNlePlugin.mm,876] QUEUE PERFORMANCE: Time between renders 161
msecs.

See Also
• Log Files
• Tuning the NLE System

7.3.5

Rendering with Viz Engine
• Which Viz Engine version should I run for HD?
• A standard-PC version for all HD output is recommended due to a number
of issues in the INCA version.
• How can I see if off-screen rendering works with Viz Engine 2.8?
• The Viz Engine screen should be grayed out, and have no extra black
window in the corner. If the black window is there, off-screen rendering
does not work. For details, see the Graphics Rendering section.
• How do I design scenes for NLE use?
• Always remember to use key or else the graphics will not blend with the
video.
• The basic setup is to use one stop point. This will be automatically
converted to a pause point and stretched. With the stop-point on the root
director (first director in the list) it is possible to decide where the scene or
effect will be stretched before continuing the out-animation.
See Also
• Graphics Rendering

7.3.6

Configuring Graphics Cards
• How do I configure my NVIDIA card with Avid and Viz NLE plugin?
• From Avid’s release notes: “In the Open GL Settings tab of the Windows

Display Properties dialog box, the Multi-Display hardware acceleration
should be set to Single Display mode. The default setting is Multi-Display
Performance mode. This is the mode that appears if a new version of the
NVIDIA driver is installed. If the setting is anything other than Single Display
mode, the Avid application might drop frames during real-time playback of
3D effects.”

• For more information, see the Avid Suites section.
See Also
• Avid Suites
• Graphics Rendering
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